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 Important Information

Warranty
The USB-8486 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by 
receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the 
warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in 
materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments 
will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects 
during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any 
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by 
warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In 
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document 
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National 
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING 
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of 
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against 
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service 
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the 
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside 
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
LabVIEW, National Instruments, NI, ni.com, the National Instruments corporate logo, and the Eagle logo are trademarks of National 
Instruments Corporation. Refer to the Trademark Information at ni.com/trademarks for other National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, 
partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products/technology, refer to the appropriate location: Help»Patents in your software, 
the patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE 
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, 
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR 
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF 
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY 
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, 
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, 
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS 
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION 
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY 
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER 
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT 
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

Electromagnetic Compatibility Information
This hardware has been tested and found to comply with the applicable regulatory requirements and limits for electromagnetic 
compatibility (EMC) as indicated in the hardware’s Declaration of Conformity (DoC)1. These requirements and limits are 
designed to provide reasonable protection against harmful interference when the hardware is operated in the intended 
electromagnetic environment. In special cases, for example when either highly sensitive or noisy hardware is being used in close 
proximity, additional mitigation measures may have to be employed to minimize the potential for electromagnetic interference.

While this hardware is compliant with the applicable regulatory EMC requirements, there is no guarantee that interference will 
not occur in a particular installation. To minimize the potential for the hardware to cause interference to radio and television 
reception or to experience unacceptable performance degradation, install and use this hardware in strict accordance with the 
instructions in the hardware documentation and the DoC1.

If this hardware does cause interference with licensed radio communications services or other nearby electronics, which can be 
determined by turning the hardware off and on, you are encouraged to try to correct the interference by one or more of the 
following measures:
• Reorient the antenna of the receiver (the device suffering interference).
• Relocate the transmitter (the device generating interference) with respect to the receiver.
• Plug the transmitter into a different outlet so that the transmitter and the receiver are on different branch circuits.

Some hardware may require the use of a metal, shielded enclosure (windowless version) to meet the EMC requirements for 
special EMC environments such as, for marine use or in heavy industrial areas. Refer to the hardware’s user documentation and 
the DoC1 for product installation requirements.

When the hardware is connected to a test object or to test leads, the system may become more sensitive to disturbances or may 
cause interference in the local electromagnetic environment.

Operation of this hardware in a residential area is likely to cause harmful interference. Users are required to correct the 
interference at their own expense or cease operation of the hardware.

Changes or modifications not expressly approved by National Instruments could void the user’s right to operate the hardware 
under the local regulatory rules.

1   The Declaration of Conformity (DoC) contains important EMC compliance information and instructions for the user or 
installer. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.
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About This Manual

This manual contains instructions on how to install and configure the 
National Instruments USB-8486 and the NI-FBUS software. The 
USB-8486 is intended for use in computers equipped with a USB port.

How To Use the Manual Set
Use the FOUNDATION™Fieldbus Overview to learn the basics of Fieldbus. 
The FOUNDATION™ Fieldbus Overview also includes tutorials to lead you 
through developing a simple Fieldbus application.

Use this getting started manual to install and configure your USB-8486 and 
the NI-FBUS software in the Windows system environment. Basic 
installation instructions also can be found in the FOUNDATION™ Fieldbus 
Hardware and NI-FBUS Software for Windows Installation Guide.

If you are using the NI-FBUS Configurator, use the NI-FBUS Configurator 
User Manual to install and use the NI-FBUS Configurator software.

If you are using the NI-FBUS Communications Manager Application 
Programmer Interface (API), use the NI-FBUS Communications Manager 
User Manual to learn how to use the NI-FBUS Communications Manager 
API for your application. Use the NI-FBUS Communications Manager 
Function Reference Manual to look up specific information about 
NI-FBUS Communications Manager functions, such as syntax and error 
messages.
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Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names and hardware labels.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. This font also emphasizes lines of code 
that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

NI-FBUS software In this manual, the term NI-FBUS software refers to either the NI-FBUS 
Communications Manager or NI-FBUS Configurator software.

USB-8486 In this manual, the term USB-8486 refers to the NI USB-8486 
FOUNDATION™ Fieldbus interface card.
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Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

General Fieldbus Web sites:

• Fieldbus Foundation—Responsible for the definition of the 
FOUNDATION™ Fieldbus specification. www.fieldbus.org

• Relcom, Inc.—Wiring and test equipment for FOUNDATION™ Fieldbus. 
www.relcominc.com/fieldbus

• Fieldbus, Inc.—Device developers and FOUNDATION™ Fieldbus 
consulting. www.fieldbusinc.com

Fieldbus system development documentation:

• Fieldbus Foundation resources

– Wiring and Installation 31.25 kbit/s, Voltage Mode, Wire Medium 

• Relcom Fieldbus resources online

– Wiring Design and Installation Guide

– Online Tutorial

– FAQ

– Sample Fieldbus Topologies

• Fieldbus Standard for Use in Industrial Control Systems, Part 2, 
ISA-S50.02.1992

Fieldbus device development documentation:

• Developing Your First FOUNDATION™ Fieldbus Device, available from 
the Fieldbus, Inc. Web site at www.fieldbusinc.com 

• FOUNDATION™ Specification: 31.25 kbit/s Physical Layer Profile for the 
FOUNDATION™ Fieldbus Physical Layer Specifications

• Function Block Application Process, Part 1

• Function Block Application Process, Part 2

• IEC Standard 1158-2 and ISA Standard ISA S50.02

Other related documentation:

• USB Specification, Release 2.0, Universal Serial Bus (USB)
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1
Introduction

This chapter lists what you need to get started and includes a brief 
description of the USB-8486 hardware and the NI-FBUS software.

What You Need to Get Started
To install your NI-FBUS software, you need the following items:

❑ USB-8486 hardware

❑ Installation CD kit

❑ Windows installed on your computer

Hardware Description
The USB-8486 is a USB high-power bus-powered device that is 
compatible with both USB 2.0 High-Speed and Full-Speed ports. The 
USB-8486 is a FOUNDATION™ Fieldbus interface device which handles 
communication between a USB-compatible computer and one or more 
network-configurable devices that comply with the FOUNDATION™ Fieldbus 
H1 specification. The USB-8486 uses an embedded processor to integrate 
FOUNDATION™ Fieldbus H1 Stack and supports the FOUNDATION™ Fieldbus 
transfer rate of 31.25 kb/s.

Software Description
Your kit includes either the NI-FBUS Communications Manager software 
or the NI-FBUS Configurator software. Depending on the system you 
purchase, you may receive both disks. If this is the case, use the NI-FBUS 
Configurator software.

The NI-FBUS Communications Manager software is used by the interface 
boards to communicate over the bus. Additionally, it provides a high-level 
API advanced users can use to interface with the National Instruments 
FOUNDATION™ Fieldbus communication stack and hardware. 
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Most users use the NI-FBUS Configurator. In addition to providing the 
functionality of the NI-FBUS Communications Manager in a graphical 
format, it includes additional functionality to allow you to configure 
a Fieldbus network. It can automatically generate the schedule for the 
network and configure field devices and hosts to transmit and receive 
alarms and trends.

Choosing Configuration Software
FOUNDATION™ Fieldbus links must be configured. Only with configuration 
software can you do things like set device addresses, clear devices, and 
download (necessary if you are setting up a system for the first time). 
Your configuration software must match the interface card your computer 
is using to connect to the bus. National Instruments offers the NI-FBUS 
Configurator with a National Instruments FOUNDATION™ Fieldbus interface 
card to let you configure your Fieldbus links.

Interface cards and configuration software are sold separately because 
multiple interface cards can reside in the same computer. The NI-FBUS 
Configurator, by default, is licensed for use on one machine, with up to four 
Fieldbus links (segments). If you have more than four links (ports on the 
cards), you need to purchase a link upgrade for each link in excess of four. 
To do so, download the order form from ni.com/fieldbus.

Note The connection to one interface port on the interface card is viewed as one link 
by the NI-FBUS Configurator, regardless of how many links might actually be joined 
by repeaters. This is important for software licensing of the NI-FBUS Configurator.

If you only want to use the card to read and write values only (not 
configure) and you are a programmer, you can make calls to the API in 
the NI-FBUS Communications Manager and do not need the NI-FBUS 
Configurator. This is possible only if you have already used third-party 
hardware and configuration software to configure the link.
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Table 1-1 describes the National Instruments Fieldbus software.

Table 1-1.  National Instruments Fieldbus Software

Software Application Short Name Description File Name

NI-FBUS 
Communications 
Manager

NIFB process This must be running 
for you to use the 
USB-8486 as a 
Fieldbus interface to 
communicate between 
the card and the bus.

nifb.exe

NI-FBUS Interface 
Configuration Utility

Interface Config Used to configure the 
USB-8486.

fbconf.exe

NI-FBUS 
Configurator

NI-FBUS 
Configurator

Used to configure the 
devices on the bus, 
set the parameters for 
control loops, and other 
Fieldbus configuration 
tasks.

fcs.exe

NI-FBUS Dialog 
System

NI-FBUS Dialog Used to view the 
devices on the bus and 
manually read and 
write parameter values. 
Not for configuration.

nifbdlg.exe

Server Explorer Server Explorer Lets you configure 
the attributes of the 
communication 
resource, device, and 
items of your network, 
and the groups and 
items of your OPC 
server.

serverexplorer.exe



Chapter 1 Introduction

USB-8486 for Windows 1-4 ni.com

Optional Fieldbus Network Tools
Your kit includes either the NI-FBUS Communications Manager software, 
the NI-FBUS Configurator software, or both. In addition, you can order 
LabVIEW DSC and/or Lookout from National Instruments. If you have not 
already done so, you also can order the NI-FBUS Configurator.

LabVIEW DSC helps you perform data acquisition and analysis, create 
a human-machine interface (HMI), or develop an advanced supervisory 
control application in a graphical development environment. 
LabVIEW DSC includes real-time process monitoring, historical trending, 
alarm and event reporting, online configuration, and PLC connectivity.

Lookout helps you create graphical representations on a computer screen 
of real-world devices such as switches, dial gauges, chart recorders, 
pushbuttons, knobs, sliders, and meters. After linking these images to your 
field instruments, you can configure Lookout to generate alarms, log data 
to disk, animate custom graphics, print reports, automatically adjust 
setpoints, historically trend information, warn operators of malfunctions, 
and so on.
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2
Installation and Configuration

Note These installation and configuration instructions only apply for Windows.

Installing the Software
Complete the following steps to install your NI-FBUS software.

Caution If you are reinstalling the NI-FBUS software over an existing version, write down 
your card configuration and any port configuration parameters you changed from their 
defaults. Reinstalling may cause you to lose any existing card and port configuration 
information.

1. Log in as Administrator or as a user that has Administrator 
privileges.

2. Insert the NI-FBUS program CD.

3. Select Start»Run.

4. In the Run dialog box, type the following:

x:\setup

where x is the letter of the drive containing the disk (usually a or b).

The interactive setup program takes you through the necessary steps to 
install the software.

The installation program copies nifbusb4u.dll into your \System32 
directory, and it copies the nifbusb4k.sys driver into the \drivers 
directory. The installation program also adds information to the Windows 
Registry. 

Continue to the Installing the Hardware section to configure and install 
your card.
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Installing the Hardware

Cautions Operate the USB-8486 only as described in operating instructions.

Do not unplug the USB-8486 when the software is running.

Figure 2-1.  Connecting the USB-8486 to a Desktop PC

1 Desktop PC 2 USB-8486 3 DB-9 Connector

2

1

3
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Figure 2-2.  Connecting the USB-8486 to a Portable PC

To install the USB-8486, complete the following steps.

1. Power on the computer and allow the operating system to boot.

2. Insert the USB-8486 into an available USB port on the system, 
as shown in Figure 2-1 or Figure 2-2.

3. Connect the USB-8486 to the Fieldbus network. Refer to the NI-FBUS 
Hardware and Software User Manual for more information about the 
connectors.

4. Launch the Interface Configuration Utility.

5. Right-click the USB-8486 to enable.

6. Close the Interface Configuration Utility and start the NI-FBUS 
Communications Manager or NI-FBUS Configurator.

1 Portable Computer 2 USB Port 3 USB-8486 4 DB-9 Connector

1

2

3
4
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Note Use a USB 2.0 high power port to ensure proper bus powering. For a desktop PC, 
it is usually a rear USB port.

Setting the Communication Parameters and 
Interface Name

Complete the following steps to use the NI-FBUS Interface Configuration 
utility to set the Fieldbus communication parameters and interface name.

1. Start the NI-FBUS Interface Configuration utility by selecting 
Start»Programs»National Instruments FBUS»Interface 
Configuration Utility.

2. Select the port you want to edit, and click the Edit button. 

The NI-FBUS Interface Configuration utility displays the default 
interface name and some configuration information.

3. Enter an interface name for the port, or use the default name. 
The interface name is for local use on the PC.

4. Enter a unique tag in the Device Tag field, or use the default device tag. 
The device tag is the name visible on the Fieldbus to the other devices.

5. Your interface must be given either a fixed or visitor device address for 
you to start using NI-FBUS. This address must be unique on the link 
to which the interface is connected.

a. To assign a fixed address to your Fieldbus interface, choose Fixed 
Address and enter a value in the range 0x10 to 0xF7.

By convention, the lower addresses starting at 0x10 are usually used 
for interface boards and link masters. Upper addresses, starting at 
0xF7 and working down, are generally used for other devices. 
Using a lower address for your interface will reduce the likelihood 
that the interface will conflict with another device on the bus.

b. If you want your interface to be a temporary device that you do not 
intend to connect to the Fieldbus for an extended time, choose 
Visitor Address. Over a long period of time, using a visitor address 
could break VCR endpoints and cause VCR_FULL_ERROR errors.

c. If you want third-party Fieldbus configuration software to assign 
an address to your interface over the Fieldbus, choose Default 
Address. You should only choose to use a default address when 
you want third-party configuration software to assign a permanent 
address. A device at a default address cannot be communicated 
with until a permanent address has been assigned by the 
configuration software.
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6. Select a Device Type. You should choose to use Link Master Device.

7. Make sure that NI-FBUS is selected for Usage. Refer to the Optional 
Fieldbus Network Tools section of Chapter 1, Introduction, for more 
information.

NI-FBUS assigns default values for other network communication 
parameters. 

Caution Do not modify the Advanced parameters without good reason. If you must 
modify parameters for certain devices, the device manufacturer will recommend settings. 
Modifying these parameters can have an adverse affect on data throughput rates. If settings 
are incorrectly modified, some devices might disappear off the bus.

8. Click OK, and then click OK again to exit the configuration utility.

9. Restart the NIFB process to make the changes you made in the 
NI-FBUS Interface Configuration utility take effect.

10. Replace the top cover on your computer, if you have not done so 
already.

Testing the Installation
Start the NIFB process by selecting Start»Programs»National 
Instruments»NI-FBUS»NI-FBUS Communications Manager.

Tip You can have the device driver start automatically when your computer boots. 
Refer to Chapter 3, Starting the NIFB Process, for instructions.

If NI-FBUS does not start up successfully, refer to Appendix C, 
Troubleshooting and Common Questions.

Changing or Deleting Existing Interface Information
To change or delete information about any interface that you have already 
entered, complete the following steps:

1. Select Start»Programs»National Instruments»NI-FBUS»Utilities»
Interface Configuration Utility.

2. Click the Boardx icon, where x refers to the board number of the 
interface you want to change or delete. 

3. Click the Edit button. You can edit the interface configuration 
information that you entered earlier, or click Delete to delete this 
interface entirely.
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Interfaces are numbered beginning with zero. If you delete an interface, 
the NI-FBUS Interface Configuration utility renumbers all the remaining 
interfaces. For example, if you delete Board0, it appears that you deleted 
the last interface, because all the remaining interface numbers are 
decreased by one automatically.

Run the NI-FBUS Interface Configuration utility once to make sure the 
interface has been removed.

To reinstall the interface, refer to the installation and configuration 
instructions earlier in this chapter.

Note If one USB-8486 is unplugged and you want to use other interfaces in the system, 
delete this USB-8486 from the Interface Configuration Utility before running the NIFB 
process.

Importing Device Descriptions
The device description files contain information about the types of blocks 
and parameters supported by your Fieldbus device, along with online help 
describing the uses of given parameters. If your Fieldbus device uses 
manufacturer-specific device description files, you must import the device 
description files shipped with the device or available from the device 
manufacturer. To do so, complete the following steps:

1. Insert the device description disk or CD, if supplied by your Fieldbus 
device manufacturer, into the disk drive of the host computer.

2. Select Start»Programs»National Instruments»NI-FBUS»Utilities»
Interface Configuration Utility to run the Interface Configuration 
utility.

3. Click the DD Info button. The DD Info dialog box opens.

Table 2-1.  Board Renumbering

Original Address Address after Deleting Board1

Board0 Board0

Board1 (deleted)

Board2 Board1

Board3 Board2
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4. If the base directory field is blank, enter a base directory. The base 
directory you enter here will be where NI-FBUS looks for all device 
descriptions. Do not change the base directory after you have started 
importing device descriptions. Otherwise, NI-FBUS will not be able 
to find the device descriptions you previously imported. Your device 
description files will automatically be placed in the appropriate 
manufacturer ID subdirectory under this base directory. 

Your base directory will include one folder for each different manufacturer 
for which you have imported device description. For example, if you 
import the device description for a National Instruments FOUNDATION™ 
Fieldbus device, you will find a folder called 4e4943. This is the 
manufacturer ID number for National Instruments FOUNDATION™ Fieldbus 
devices.

The next layer of folders is the device type. Underneath this layer of 
directories you will find the individual device description files 
(.ffo/.ff5 and .sym/sy5).

5. If necessary, click the Browse button to select the standard text 
dictionary, provided with NI-FBUS. The text dictionary has a .dct 
extension.

6. Click the Import DD button. The Import DD dialog box opens.

7. Click the Browse button, browse to the .ffo/.ff5 device description 
file path, and click Open. Typically, the device description for your 
Fieldbus device is supplied on a disk from the manufacturer. For each 
device, there are two device description files, one that ends in .ffo or 
.ff5 and one that ends in .sym or sy5. Select the .ffo/.ff5 file, 
and the corresponding .sym/.sy5 file will be imported automatically. 
The file name will be in the form 
Digit Digit Digit Digit.ffo/.ff5 (for example, 0101.ffo 
or 0101.ff5).

Note If you are importing device descriptions for multiple devices, you might see that they 
can have the same filenames. Each file contains information about the device and its 
manufacturer, and will be placed appropriately in the hierarchy under the base directory.

8. Click OK. A window opens that gives the full path to where the 
.ffo/.ff5 and .sym/sy5 files were copied.

9. Click OK.

For more information on device descriptions, refer to the The Role of 
Device Descriptions section of the FOUNDATION™ Fieldbus Overview 
document.
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3
Starting the NIFB Process

The NIFB process must be running any time you want to use your 
USB-8486 as a Fieldbus interface to communicate between the device and 
the bus.

Note You also can start the driver by entering net start nifb at the command prompt.

Beginning to Use Your NI-FBUS Software
If you are using the NI-FBUS Communications Manager, refer to the 
NI-FBUS Communication Manager User Manual for information on using 
your software. If you are using the NI-FBUS Configurator, refer to the 
NI-FBUS Configurator User Manual for information on using your 
software.

If NI-FBUS is unable to connect to and initialize an interface device 
and you decide to continue NI-FBUS startup, NI-FBUS will not try to 
reconnect to that interface again. This is true of all interface types supported 
by this software.

If a USB-8486 is configured as a basic device, a link master device must be 
present on this link before NI-FBUS will start up.
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A
Specifications

This appendix describes the electrical, physical, and environmental 
characteristics of the USB-8486 hardware and the recommended operating 
conditions.

Bus Interface
USB........................................................ USB 2.0 High-Speed or 

Full-Speed1

FOUNDATION™ Fieldbus ........................... Standard H1 interface2

Power Requirement
USB High-power Bus-powered Device

Working Mode Current .......................... 300 mA maximum
(full temperature range)
180 mA typical
(at 25 °C)

Suspend Current ..................................... 2.5 mA maximum
(full temperature range)

Physical
Dimensions............................................. 7.87 × 6.35 × 2.54 cm 

(3.1 × 2.5 × 1.0 in.)

Weight .................................................... 165 g (5.82 oz)

Captive USB cable length ...................... 2 m

I/O connector

USB................................................. Standard series A plug

FOUNDATION™ Fieldbus
H1 Interface .................................... 9-pin male D-Sub

1   Using the USB-8486 in full-speed mode reduces device performance.
2   Galvanically isolated.
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Environment

Operating Environment
Ambient temperature ..............................0 to 55 °C

Relative humidity ...................................10 to 90%, noncondensing 
(tested in accordance with 
IEC-60068-2-1, IEC-60068-2-2, 
EC-60068-2-56)

Altitude ...................................................2,000 m

Pollution Degree .....................................2 (IEC-60664-1:2007)

Indoor use only.

Storage Environment
Ambient temperature ..............................–20 to 70 °C

Relative humidity ...................................5 to 95%, noncondensing 
(tested in accordance with 
IEC-60068-2-1, IEC-60068-2-2, 
EC-60068-2-56)

Safety
This product meets the requirements of the following standards of safety 
for electrical equipment for measurement, control, and laboratory use:

• IEC 60950-1, EN 60950-1

• UL 60950-1, CSA 60950-1

Note For UL and other safety certifications, refer to the product label or the Online 
Product Certification section.

Electromagnetic Compatibility
This product meets the requirements of the following EMC standards for 
electrical equipment for measurement, control, and laboratory use:

• EN 61326-1 (IEC 61326-1): Class A emissions; Basic immunity

• EN 55011 (CISPR 11): Group 1, Class A emissions

• AS/NZS CISPR 11: Group 1, Class A emissions

• FCC 47 CFR Part 15B: Class A emissions

• ICES-001: Class A emissions
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Note For EMC declarations and certifications, refer to the Online Product Certification 
section.

Note For EMC compliance, operate this device with shielded cables and accessories.

CE Compliance
This product meets the essential requirements of applicable European 
Directives as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

Online Product Certification
To obtain product certifications and the Declaration of Conformity (DoC) 
for this product, visit ni.com/certification, search by model number 
or product line, and click the appropriate link in the Certification column.

Environmental Management
NI is committed to designing and manufacturing products in an 
environmentally responsible manner. NI recognizes that eliminating certain 
hazardous substances from our products is beneficial to the environment 
and to NI customers.

For additional environmental information, refer to the NI and the 
Environment Web page at ni.com/environment. This page contains the 
environmental regulations and directives with which NI complies, as well 
as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of the product life cycle, all products must be sent to a WEEE 
recycling center. For more information about WEEE recycling centers, National 
Instruments WEEE initiatives, and compliance with WEEE Directive 2002/96/EC on 
Waste and Electronic Equipment, visit ni.com/environment/weee.

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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B
Pinout Information

This appendix contains information about the pinout of the Fieldbus 
connector.

The USB-8486 hardware has a 9-pin male D-SUB (DB-9) connector for the 
H1 port.

Figure B-1 shows the male DB-9 connector pinout. 

Figure B-1.  Male DB-9 Connector Pinout

The pinout of the USB-8486 uses pins 6 and 7 of the connector for the 
Fieldbus signals as specified in the Fieldbus Standard for Use in Industrial 
Control Systems, Part 2, ISA-S50.02.1992.

9-Pin D-SUB (DB-9) Cable Information
A 2-meter cable has been included in your kit which converts the 9-pin 
D-SUB connector to three wire pigtails.

1
2

3
4

5

6
7

8
9

No Connection

No Connection 

No Connection

No Connection

No Connection

No Connection

No Connection

Data – 

Data +
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Figure B-2.  DB-9 Cable for the USB-8486

Figure B-3 shows the pinout of the 9-pin D-SUB female connector so you 
can make your own cable if you need a longer cable than the one provided 
in your kit.

Figure B-3.  Pinout for 9-Pin D-SUB Female Connector of the DB-9 Cable

Table B-1 provides the cable pigtail “pinout”.

All of the signals on the three wire pigtails provide a direct corresponding 
connection to the 9-pin D-SUB.

Table B-1.  Information for Cable Pigtails

Signal Color Size

Data + Red 22 AWG

Data – Black 22 AWG

Shield Green 22 AWG

5
4

3
2

1

9
8

7
6

No Connection

No Connection 

No Connection

No Connection

No Connection

No Connection

No Connection

Data + 

Data –
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C
Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot common problems that occur 
while getting started with Fieldbus.

Error Messages
Utility could not access or locate the registry.

• Make sure you are logged in to Windows with administrator privileges.

• Your registry entries for NI-FBUS may have been deleted or corrupted. 
Uninstall, then reinstall the NI-FBUS software as described in the 
Installing the Software section of Chapter 2, Installation and 
Configuration.

NIFB could not locate any usable Fieldbus boards.

Stop the card, remove it, then reinsert it.

Board cannot be found.

• Select Start»Programs»National 
Instruments»NI-FBUS»Utilities»Interface Configuration Utility. 
Make sure your card appears under the list of interfaces.

• Make sure the kernel-mode driver is started. To start the driver, select 
Start»Programs»National Instruments»NI-FBUS»NI-FBUS 
Communications Manager. Click the Start button. To avoid manual 
startup in the future, click Startup and select Automatic.

When using the USB-8486, Nifb returns an error message stating that 
the configured board does not exist.

Ensure that the USB-8486 has not been unplugged.

• If you want to use the USB-8486 again, complete the following steps.

1. Connect the USB-8486 to an available USB port on the system.
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2. Select Start»Programs»National Instruments»NI-FBUS»
Utilities»Interface Configuration Utility.

3. Right-click the USB-8486 to enable it.

• If you want to use other interfaces in the system without this 
USB-8486, complete the following steps.

1. Select Start»Programs»National Instruments»NI-FBUS»
Utilities»Interface Configuration Utility.

2. Right-click the USB-8486 to delete it.

VCR_FULL_ERROR

Delete the card from the Interface Configuration utility, then reinstall. 

NIFB Problems
When using the USB-8486, Nifb returns an error message stating that 
the board cannot be found.

• Select Start»Programs»National 
Instruments»NI-FBUS»Utilities»Interface Configuration Utility. 
Make sure your card appears under the list of interfaces.

• Make sure the kernel-mode driver is started. To start the driver, select 
Start»Programs»National Instruments»NI-FBUS»NI-FBUS 
Communications Manager. Click the Start button. To avoid manual 
startup in the future, click Startup and select Automatic.

When a Fieldbus device is connected to the bus, the NIFB process 
often hangs when the title bar reads Waiting for Startup 
Completion. If I disconnect the cables, it starts fine.

This is probably due to a device address conflict. In the NI-FBUS Interface 
Configuration utility, make sure that the interface is not at the same address 
as anything else on the link. You also can temporarily give the interface 
a visitor address to troubleshoot this problem.

The NIFB process hangs, does not start up, or never shows that it is 
running.

• The Fieldbus network address is not unique. Remove the cable from 
the card. Restart the NIFB process. If it runs successfully, there is 
probably a Fieldbus network address conflict. If this does not solve the 
problem, you can try to change the card’s address. In the Interface 
Configuration utility, select the port and click Edit. Make sure that the 
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port does not have an address that conflicts with another device on the 
bus. You also can set the interface to a visitor address. In this case, the 
card will find and take an unused address. If this corrects the problem, 
find and change the address of one of the conflicting devices. Return 
the card to a fixed address.

• Check for multiple copies of nifb.dll on the machine. If multiple 
copies are found, NI-FBUS was incorrectly reinstalled. Uninstall 
NI-FBUS, search for any remaining copies of nifb.dll, delete them, 
then reinstall the software.

• You can check the Windows Device Manager to see if Windows has 
detected any problems or conflicts in the resources assigned to your 
card. Your card(s) will appear under the Fieldbus Adapters category. 
The Device Manager displays an exclamation mark (!) on the icon of 
any card that has resource conflicts.

• Check how many cards are showing up in the Interface Configuration 
utility. Make sure that this matches the number of cards in the system. 
Also check that the number of ports match the physical hardware 
(one port versus two port cards).

• Link masters do not always get along together if you have another link 
master on the link. Try setting the card to be a basic device in the 
Interface Configuration utility. 

If a USB-8486 is configured as a basic device, another link master 
device must be present on this link before the NI-FBUS process will 
start up. For more information about Basic and Link Master devices, 
refer to the Fieldbus Overview document.

Interface Configuration Problems
When using the NI-FBUS Interface Configuration utility, the error 
message utility could not access or locate the registry appears.

• Make sure you are logged in to Windows with Administrator 
privileges.

• Your registry entries for NI-FBUS may have been deleted or corrupted. 
Uninstall, then reinstall the NI-FBUS software as described in the 
Installing the Software section of Chapter 2, Installation and 
Configuration.

• For the USB-8486, removing third-party card manager software also 
has been known to correct such problems.
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In the Interface Configuration Utility, I see more boards than what 
physically exist in the machine.

Select Edit for the extra card. In the next window, select Delete.

Caution Do not attempt to make unguided changes in the Windows registry. Doing so can 
cause many problems with your system.

Add New Hardware Problems
In Add New Hardware on Windows, there is no category for Fieldbus.

The category Fieldbus Adapters will not appear under the type of 
hardware listing in Add New Hardware unless you restart the computer 
twice after installing the software. After you install your first card, it will 
always show up.

Resolving Resource Conflicts

Use a Visitor Address
Using a visitor address is a good way to troubleshoot an address conflict 
since the card will find and take an available address.

Problems Using Manufacturer-Defined Features
NI-FBUS uses identifying information in the actual device to locate the 
device description for the device. The identifying information includes four 
resource block parameters: MANUFAC_ID, DEV_TYPE, DEV_REV, and 
DD_REV. If the identifying information is incorrect, NI-FBUS will not be 
able to locate the device description for the device. When it has located the 
device description, NI-FBUS matches the block types in the device 
description with the actual blocks in the device by using the Item ID of the 
block characteristics record. 

If the blocks in the device do not match the blocks in the description, or if 
there is no appropriate device description for the manufacturer, device type, 
device revision, and device description revision being returned by the 
device, then there is a device description mismatch. In either case, 
NI-FBUS uses only the standard dictionary (nifb.dct) and you will 
be unable to use any manufacturer-supplied functionality.
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These parameters can be read from the device resource block. 
The following procedure will help you troubleshoot a 
DD_SIZE_MISMATCH_ERROR by finding out if there is a device description 
available on your computer that matches what your device expects.

Complete the following steps to use the NI-FBUS Dialog utility to check 
device description files:

1. Start the NIFB process. Wait until the process has finished initializing.

2. Select Start»Programs»National 
Instruments»NI-FBUS»Utilities»Dialog.

3. Right-click Open Descriptors and choose Expand All.

4. After the expansion is complete, click Cancel to close the Expand All 
window.

5. Right-click the resource block for your device by selecting Read 
Object from Open Descriptors»Session»Interface Name»Device 
Name»VFD Name»Resource Block Name.

6. Select the Read by Name radio button and enter MANUFAC_ID as the 
name. Click the Read button. Write down the hexidecimal number 
found in parenthesis (0xnumber) in Table C-1.

7. Repeat step 6 for the name DEV_TYPE.

8. Repeat step 6 for the name DEV_REV.

9. Repeat step 6 for the name DD_REV.

10. Repeat steps 5 through 9 for each device, then close the NI-FBUS 
Dialog utility.

11. In the Interface Configuration utility, click the DD Info button. Write 
down the base directory specified for device descriptions. Close the 
Interface Configuration utility.

12. Use Windows Explorer to view the contents of the base directory 
specified in the Interface Configuration utility. The Fieldbus 

Table C-1.  Device Names

Resource Block Parameter Name

MANUFAC_ID

DEV_TYPE

DEV_REV

DD_REV
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specification defines the directory hierarchy for storing device 
descriptions. There is a different subdirectory for each device 
manufacturer. Under the base directory, you should see a directory 
with the number from step 6 for the first device.

13. Under the appropriate manufacturer directory, there is a directory for 
each device type that you have from that manufacturer. Make sure that 
you see a directory with the number from step 7.

14. Under the appropriate device type directory, there are the individual 
device descriptions. The device description file name is a combination 
of the device revision (the number from step 8) and the device 
description revision (the number from step 9). The device revision is 
the first two digits, and the device description revision is the second 
two digits. For example, if your number from step 8 was 2 and from 
step 9 was 1, you should see files called 0201.ffo and 0201.sym. 
Device descriptions are backwards compatible. This means that 
instead of seeing 0201, you might see 0202. This is allowed by the 
Fieldbus specification. Also, having additional files in this directory 
is not a problem. The Configurator will use the most recent device 
description revision for a given device revision. If you do not have 
the appropriate .ffo and .sym files, you must obtain them from the 
device manufacturer. Be sure to import them properly by clicking 
DD Info and using the Import DD button in the Interface 
Configuration utility. 

15. Repeat steps 12 through 14 for each device.

The second cause for this problem is when the contents of the file do 
not accurately describe the device characteristics, even if the device 
identification information matches the file identification information. 
This problem is caused when a device manufacturer makes a change to 
the firmware of the device without incrementing the device revision, in 
violation of the FOUNDATIONTM Fieldbus recommendation. If this is the case, 
you must contact your device manufacturer for a resolution.

Configuring Advanced Parameters

Caution Do not modify the Advanced parameters without good reason. If you must 
modify parameters for certain devices, the device manufacturer will recommend settings. 
Modifying these parameters can have an adverse affect on data throughput rates. If settings 
are incorrectly modified, some devices might disappear from the bus. 
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In the NI-FBUS Interface Configuration utility, click the Advanced button 
on the dialog box for the port you want to configure. Figure C-1 shows the 
Advanced Stack Configuration dialog box. 

Figure C-1.  Advanced Stack Configuration Dialog Box

The parameters involved in setting addresses are T1 and T3. These 
parameters represent delay time values that your card uses to compensate 
for the delays inherent in the device and in the set address protocol itself. 
T1 describes the expected response delay of the device at a given address. 
T3 describes the expected time for the device to respond at its new address.

Uninstalling the Software
To uninstall your NI-FBUS software, select Start»Settings»Control 
Panel»Add/Remove Programs.

If you are only using the Communications Manager, select NI-FBUS 
Communications Manager to uninstall. If you are using the NI-FBUS 
Configurator, select NI-FBUS Configurator.
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The uninstall utility does not remove the NI-FBUS directory itself or any 
files in the \Data\Nvm directory. To completely uninstall the software, 
manually remove the files in the \Data\Nvm directory and the NI-FBUS 
directory structure.

USB-8486 Troubleshooting
The H1 Fieldbus LED flashes red.

The USB-8486 encountered an error during the Power-On Self-Test 
(P.O.S.T.). Complete the following steps to correct the issue.

1. Remove the USB-8486 from the computer and close NI-FBUS 
Communications Manager.

2. Connect the USB-8486 to another USB port in the system.

3. Start the NI-FBUS Communication Manager.

If the H1 Fieldbus LED still flashes red, contact National Instruments 
through the information provided in Appendix D, Technical Support and 
Professional Services.

The H1 Fieldbus LED is solid red.

The USB-8486 H1 Fieldbus port encountered a fatal network error. 
Complete the following steps to correct the issue.

1. Remove the USB-8486 from the computer and close NI-FBUS 
Communications Manager

2. Re-connect the USB-8486 to the USB port of the system again.

3. Restart the NI-FBUS Communication Manager and check the H1 
Fieldbus LED state.
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USB-8486 LED Indicators
The USB-8486 has two LED indicators on the front panel, as shown in 
Figure C-2.

Figure C-2.  LEDs on the USB-8486

The USB LED is located on the front of the USB-8486, as shown in 
Figure C-2. It indicates whether the USB-8486 is powered, configured, and 
operating properly. Table C-2 shows how to interpret the USB LED states.

1 H1 Fieldbus Port Status 2 USB Status

Table C-2.  Interpretation of USB-8486 USB STATUS LED

LED State Meaning

Off There is no power on the USB port , the USB-8486 is 
disabled, or an error has occurred.

Solid green The USB-8486 is working in USB 2.0 full speed 
mode.

Solid amber The USB-8486 is working in USB 2.0 high speed 
mode.

1

2

NI USB-8466
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The H1 Fieldbus port on the USB-8486 has an LED to indicate the 
functional states of the port. Table C-3 describes each state.

For more information about error handling, refer to the Error Messages 
section of this appendix.

Table C-3.  Interpretation of USB-8486 H1 Fieldbus Status LED

LED State Meaning

Off The USB-8486 has not been initialized.

Solid green The Fieldbus port is disconnected from the network 
or receiving nothing.

Slow flashing 
green

The Fieldbus port is only receiving/transmitting 
network maintenance packets.

Fast flashing 
green

The Fieldbus port is receiving/ transmitting payload 
traffic packets.

Flashing red The USB-8486 encountered an error during the 
P.O.S.T.

Solid red The Fieldbus port encountered a fatal network error.
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D
Technical Support and 
Professional Services

Visit the following sections of the award-winning National Instruments 
Web site at ni.com for technical support and professional services:

• Support—Technical support at ni.com/support includes the 
following resources:

– Self-Help Technical Resources—For answers and solutions, 
visit ni.com/support for software drivers and updates, 
a searchable KnowledgeBase, product manuals, step-by-step 
troubleshooting wizards, thousands of example programs, 
tutorials, application notes, instrument drivers, and so on. 
Registered users also receive access to the NI Discussion Forums 
at ni.com/forums. NI Applications Engineers make sure every 
question submitted online receives an answer.

– Standard Service Program Membership—This program 
entitles members to direct access to NI Applications Engineers 
via phone and email for one-to-one technical support as well as 
exclusive access to on demand training modules via the Services 
Resource Center. NI offers complementary membership for a full 
year after purchase, after which you may renew to continue your 
benefits. 

For information about other technical support options in your 
area, visit ni.com/services, or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.
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• Declaration of Conformity (DoC)—A DoC is our claim of 
compliance with the Council of the European Communities using 
the manufacturer’s declaration of conformity. This system affords 
the user protection for electromagnetic compatibility (EMC) and 
product safety. You can obtain the DoC for your product by visiting 
ni.com/certification.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

μ micro 10– 6

m milli 10–3

k kilo 103

Numbers
4–20 mA system Traditional control system in which a computer or control unit 

provides control for a network of devices controlled by 4-20 mA 
signals.

A
Address Character code that identifies a specific location (or series of 

locations) in memory.

Alarm A notification the NI-FBUS Communications Manager software 
sends when it detects that a block leaves or returns to a particular 
state.

API Application Programmer Interface. 

Attribute Properties of parameters.

B
b Bits.

Bank The combination of one FieldPoint network module and one or more 
terminal bases and I/O modules.

Basic device A device that can communicate on the Fieldbus, but cannot become 
the LAS.
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Block A logical software unit that makes up one named copy of a block and 
the associated parameters its block type specifies. The values of the 
parameters persist from one invocation of the block to the next. It can 
be a resource block, transducer block, or function block residing 
within a virtual field device.

Bus The group of conductors that interconnect individual circuitry in a 
computer. Typically, a bus is the expansion vehicle to which I/O or 
other devices are connected. Examples of PC busses are the ISA and 
PCI buses.

C
C Celsius.

Cable A number of wires and shield in a single sheath.

Communication stack Performs the services required to interface the user application to the 
physical layer.

Control loop A set of connections between blocks used to perform a control 
algorithm.

Control strategy See Function Block Application.

Controller An intelligent device (usually involving a CPU) that is capable of 
controlling other devices.

D
DD See Device Description. 

Descriptor A number returned to the application by the NI-FBUS 
Communications Manager, used to specify a target for future 
NI-FBUS calls.

Device A sensor, actuator, or control equipment attached to the Fieldbus.

Device address A memory address that you use to access a device in a computer 
system.

Device Description A machine-readable description of all the blocks and block 
parameters of a device.

Device tag A name you assign to a Fieldbus device.
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Directory A structure for organizing files into convenient groups. A directory is 
like an address showing where files are located. A directory can 
contain files or subdirectories of files.

DLL See Dynamic Link Library.

Driver Device driver software installed within the operating system.

Dynamic Link Library A library of functions and subroutines that links to an application at 
run time.

E
EMI Electromagnetic interference.

Event An occurrence on a device that causes a Fieldbus entity to send the 
Fieldbus event message.

F
Field device A Fieldbus device connected directly to a Fieldbus.

Fieldbus An all-digital, two-way communication system that connects control 
systems to instrumentation. A process control local area network 
defined by ISA standard S50.02.

Fieldbus cable Shielded, twisted pair cable made specifically for Fieldbus that has 
characteristics important for good signal transmission and are within 
the requirements of the Fieldbus standard.

Fieldbus Foundation An organization that developed a Fieldbus network specifically based 
upon the work and principles of the ISA/IEC standards committees.

Fieldbus Messaging 
Specification

The layer of the communication stack that defines a model for 
applications to interact over the Fieldbus. The services FMS provides 
allow you to read and write information about the OD, read and write 
the data variables described in the OD, and perform other activities 
such as uploading/downloading data and invoking programs inside 
a device.

Fieldbus Network Address Location of a board or device on the Fieldbus; the Fieldbus node 
address.

FMS See Fieldbus Messaging Specification.

FOUNDATION™ Fieldbus 
specification

The communications network specification that the Fieldbus 
Foundation created.



Glossary

USB-8486 for Windows G-4 ni.com

Function block A named block consisting of one or more input, output, and contained 
parameters. The block performs some control function as its 
algorithm. Function blocks are the core components you control a 
system with. The Fieldbus Foundation defines standard sets of 
function blocks. There are ten function blocks for the most basic 
control and I/O functions. Manufacturers can define their own 
function blocks.

Function Block Application The block diagram that represents your control strategy.

H
H1 The 31.25 kbit/second type of Fieldbus.

hex Hexadecimal. A base-16 numbering system which uses 0–9 and A–F.

HMI Human-Machine Interface. A graphical user interface for the process 
with supervisory control and data acquisition capability.

Hz Hertz.

I
I/O Input/output.

IEC International Electrotechnical Commission. A technical standards 
committee which is at the same level as the ISO.

in. Inches.

IRQ Interrupt request.

ISA Industry Standard Architecture.

K
Kb Kilobytes.

Kbits Kilobits.

Kernel The set of programs in an operating system that implements basic 
system functions.

Kernel mode The mode in which device drivers run on Windows NT.
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L
LabVIEW DSC The LabVIEW Datalogging and Supervisory Control (DSC) Module 

builds on the power of LabVIEW for high channel count and 
distributed applications. It adds easy networking, channel and I/O 
management, alarm and event management, historical datalogging, 
real-time trending, and OPC integration to the LabVIEW 
environment.

LAS See Link Active Scheduler.

Link A FOUNDATION™ Fieldbus network is made up of devices connected 
by a serial bus. This serial bus is called a link (also known as a 
segment). 

Link Active Schedule A schedule of times in the macrocycle when devices must publish 
their output values on the Fieldbus.

Link Active Scheduler The Fieldbus device that is currently controlling access to the 
Fieldbus. A device that is responsible for keeping a link operational. 
The LAS executes the link schedule, circulates tokens, distributes 
time, and probes for new devices.

Link master device A device that is capable of becoming the LAS.

Live list The list of all devices that are properly responding to the Pass Token.

Lookout National Instruments Lookout is a full-featured object-based 
automation software system that delivers unparalleled power and 
ease of use in demanding industrial measurement and automation 
applications.

Loop See Control loop.

M
m Meters.

Manufacturer’s 
identification

An identifier used to correlate the device type and revision with its 
device description and device description revision.

Menu An area accessible from the command bar that displays a subset of the 
possible command choices. In the NI-FBUS Configurator, refers to 
menus defined by the manufacturer for a given block.

Method Methods describe operating procedures to guide a user through 
a sequence of actions.
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mode Type of communication.

N
Network address The Fieldbus network address of a device.

Nifb.exe The NIFB process that must be running in the background for you to 
use your PCI-FBUS, PCMCIA-FBUS, or USB-8486 interface to 
communicate between the board and the Fieldbus.

NI-FBUS API The NI-FBUS Communications Manager.

NI-FBUS Communications 
Manager

Software shipped with National Instruments Fieldbus interfaces that 
lets you read and write values. It does not include configuration 
capabilities.

NI-FBUS Configurator National Instruments Fieldbus configuration software. With it, you 
can set device addresses, clear devices, change modes, and read and 
write to the devices.

NI-FBUS Fieldbus 
Configuration System

See NI-FBUS Configurator.

NI-FBUS process Process that must be running in the background for you to use your 
PCI-FBUS, PCMCIA-FBUS, or USB-8486 interface to 
communicate between the board and the Fieldbus.

O
Object An element of an object dictionary.

Object Dictionary A structure in a device that describes data that can be communicated 
on the Fieldbus. The object dictionary is a lookup table that gives 
information such as data type and units about a value that can be read 
from or written to a device.

OD See Object Dictionary. 

OPC OLE for Process Control.

P
Parameter One of a set of network-visible values that makes up a function block.

PC Personal Computer.
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Physical Layer The layer of the communication stack that converts digital Fieldbus 
messages from the communication stack to actual physical signals on 
the Fieldbus transmission medium and vice versa.

PLC See Programmable Logic Controller.

Poll To repeatedly inspect a variable or function block to acquire data.

Port A communications connection on a computer or remote controller.

Program A set of instructions the computer can follow, usually in a binary file 
format, such as a .exe file.

Programmable Logic 
Controller

A device with multiple inputs and outputs that contains a program 
you can alter.

R
Repeater Boost the signals to and from the further link.

Resource block A special block containing parameters that describe the operation 
of the device and general characteristics of a device, such as 
manufacturer and device name. Only one resource block per device 
is allowed.

Roundcard A hardware interface for developing FOUNDATION™ 
Fieldbus-compliant devices.

S
s Seconds.

Segment See Link.

Sensor A device that responds to a physical stimulus (heat, light, sound, 
pressure, motion, flow, and so on), and produces a corresponding 
electrical signal.

Server Device that receives a message request.

Session A communication path between an application and the NI-FBUS 
Communications Manager.

Shield Metal grounded cover used to protect a wire, component or piece of 
equipment from stray magnetic and/or electric fields.
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Signal An extension of the IEEE 488.2 standard that defines a standard 
programming command set and syntax for device-specific 
operations.

Stack A set of hardware registers or a reserved amount of memory used for 
calculations or to keep track of internal operations.

Static library A library of functions/subroutines that you must link to your 
application as one of the final steps of compilation, as opposed to a 
Dynamic Link Library, which links to your application at run time.

T
Tag A name you can define for a block, virtual field device, or device.

Trend A Fieldbus object that allows a device to sample a process variable 
periodically, then transmit a history of the values on the network.

U
USB Universal Serial Bus.

USB-8486 NI USB-8486 FOUNDATION™ Fieldbus interface.

V
V Volts

VCR See Virtual Communication Relationship. 

VFD See Virtual Field Device. 

Virtual Communication 
Relationship

Preconfigured or negotiated connections between virtual field 
devices on a network.

Virtual Field Device The virtual field device is a model for remotely viewing data 
described in the object dictionary. The services provided by the 
Fieldbus Messaging Specification allow you to read and write 
information about the object dictionary, read and write the data 
variables described in the object dictionary, and perform other 
activities such as uploading/downloading data and invoking 
programs inside a device. A model for remotely viewing data 
described in the object dictionary.
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Index

A
add new hardware

problems, troubleshooting, C-4
advanced parameters

advanced stack configuration dialog box 
(figure), C-7

configuring, C-6

B
board renumbering (table), 2-6

C
cable, Fieldbus (figure), B-2
CE compliance specifications, A-3
common questions, C-1

add new hardware problems, C-4
error messages, C-1
interface configuration problems, C-3
NIFB problems, C-2
problems using manufacturer-defined 

features, C-4
resolving resource conflicts, C-4

communication parameters, setting, 2-4
configuration

advanced parameters, C-6
software, 1-2

conventions used in the manual, viii

D
Declaration of Conformity (NI resources), D-2
device descriptions, importing, 2-6
device names (table), C-5
diagnostic tools (NI resources), D-1

documentation
conventions used in manual, viii
how to use manual set, vii
NI resources, D-1
related documentation, ix

drivers (NI resources), D-1

E
electromagnetic compatibility 

specifications, A-2
environmental management, A-3
error messages, C-1
examples (NI resources), D-1

F
Fieldbus, optional network tools, 1-4

H
hardware

description, 1-1
installation, 2-2

help, technical support, D-1
how to use manual set, vii

I
import device descriptions, 2-6
installation and configuration, 2-1

testing, 2-5
instrument drivers (NI resources), D-1
interface

configuration problems, 
troubleshooting, C-3

information, changing or deleting existing 
information, 2-5
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name, setting, 2-4
introduction, 1-1

K
KnowledgeBase, D-1

N
National Instruments support and 

services, D-1
network, optional tools, 1-4
NIFB

problems, troubleshooting, C-2
process, starting, 3-1

O
online product certification, A-3
optional tools, 1-4

P
pinout

connector (figure), B-1
DB-9 cable connector pinout (figure), B-2
information, B-1

programming examples (NI resources), D-1

R
recycling equipment, A-3
related documentation, ix
resource conflicts, resolving, C-4

S
safety, specifications, A-2
software

configuration, choosing, 1-2
description, 1-1

description (table), 1-3
installation, 2-1
NI resources, D-1
uninstalling, C-7
using, 3-1

specifications, A-1
bus interface, A-1
CE compliance, A-3
electromagnetic compatibility, A-2
environment, A-2

management, A-3
operating, A-2
storage, A-2

online product certification, A-3
physical, A-1
power requirement, A-1
safety, A-2
WEEE, A-3

support, technical, D-1

T
technical support, D-1
training and certification (NI resources), D-1
troubleshooting

add new hardware problems, C-4
error messages, C-1
interface configuration problems, C-3
NI resources, D-1
NIFB problems, C-2
problems using manufacturer-defined 

features, C-4
resolving resource conflicts, C-4
USB-8486, C-8
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U
uninstalling software, C-7
USB-8486

connecting
to desktop PC (figure), 2-2
to laptop PC (figure), 2-3

DB-9 cable (figure), B-2
DB-9 cable connector pinout (figure), B-2
H1 Fieldbus status LEDs

table, C-10
specifications

bus interface, A-1
CE compliance, A-3
electromagnetic compatibility, A-2
environment, A-2

management, A-3
operating, A-2
storage, A-2

online product certification, A-3

physical, A-1
power requirement, A-1
safety, A-2
WEEE, A-3

status LEDs, C-8
troubleshooting, C-8
USB status LEDs

figure, C-9
table, C-9

V
visitor address, C-4

W
Web resources, D-1
WEEE management, A-3
what you need to get started, 1-1
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